


© 2020 The Writing Centers at Saint Mary’s University of Minnesota

Intro to APA

About This Handbook: 

The first edition of this handbook 
was created by then Twin Cities 
Writing Center Director Cheryl  
Prentice in response to student and  
faculty requests for an introduction 
to the Publication Manual of the 
American Psychological Association, 
6th edition. 

Writing Center staff updated the  
resource to be more accessible in 
2018 and to adhere to the 7th  
edition in 2020.

Some tips and notes:

•	 Throughout the booklet you will see  
bracketed numbers that refer to relevant 
sections of the Publication Manual of the 
American Psychological Association (APA 
Manual). For example, [8.30] would mean 
you can look in the APA Manual in section 
8.30 for additional information. You will 
also see references to other sections of this 
handbook like this (see p. 23). 

•	 This handbook is not formatted in APA 
Style, as APA Style was designed for  
academic papers, not instructional manuals. 

•	 The booklet is not intended to replace 
the APA Manual but rather will help you 
interpret the manual and call your attention 
to some of its most important features. You 
should always refer back to the APA  
Manual as needed for more detailed  
information. 

•	 While we will provide you with APA Style 
guidelines and rules here, instructors may 
have own approach to APA Style, and you 
should always follow assignment  
instructions first. When in doubt, ask  
your instructor for their preference.

Other Writing Center Services:

The Writing Center, Twin Cities  
offers in-person, email, and phone  
consultations as well as webinars 
and workshops on a variety of  
topics. Students can also access 
writing, APA, and other resources  
on our website. Please go to 
write.smumn.edu for more  
information.  

http://write.smumn.edu
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Part One: Formatting

Alignment 
Alignment is set at the left margin for all text except some headings and the title page.  
Text should align evenly on the left margin but be ragged on the right margin, like the text 
on this page. Indent the first line of a paragraph 0.5 inches (1 Tab).

Font [2.19]
We recommend using Times New Roman size 12.  Do not use underlining or all capitals unless 
your instructor specifies these. Keep the font the same throughout the paper.         

Headings [2.27] 
Headings help both the reader and the writer follow the paper’s organizational structure. 
APA headings follow a pattern of five levels (most papers will only require the use of one to 
three levels). Headings should not be complete sentences or questions. Headings are ar-
ranged in the following hierarchy: 

								        2

Title of the Paper

Note that all essays should start with an introduction, so you do not 

use a heading for this section. 

Level 1 Heading

The Level 1 heading is bold, centered, and title case. Use Level 1 

headings to divide your paper into the major sections. 

Level 2 Heading

The Level 2 heading is bold, left-aligned, and title case. Use Level 2 

headings to subdivide Level 1 headings. 

Level 3 Heading

The Level 3 heading is bold, left-aligned, italicized, and title case.

Level 3 Heading

Use Level 3 headings to subdivide Level 2 headings.

Level 4 Heading. The Level 4 heading is bold, indented, and sen-

tence case. A Level 4 heading should be followed by a period, and the para-

graph should start right after this period (i.e., do not start a new paragraph). 

See p. 5 for information 
on title case. 

Your instructor might  
require a heading 
for your introduction. 
If so, format it like 
a Level 1 heading. 
See p. 2 for more 
information on  
introduction and  
conclusion headings.

For Level 4 and 5 headings, the 
paragraph starts right after the period 
of the heading. 

You can’t  
subdivide a  
section by one. 
Note that there 
are two Level 3  
headings here. 
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Headings [2.27], continued
Imagine you are writing a paper about your favorite shoes. Your headings might look like the 
sample here.

� 2

My Favorite Shoes

While we all wear shoes, everyone has their favorite pair or style of sh

gories of shoes that I own—casual and dress—and detail my favorite kinds of 

Casual Shoes

There are many types of casual shoes, but my favorite types are sneake

Sneakers

Sneakers are also known as tennis shoes and runners. Sneakers usually 

casual shoes or for exercise. 

Casual Sneakers

I wear casual sneakers for a lot of occasions, and I probably have at lea

sneakers made of leather, canvas, and even gold lame. I like to wear my slip-o

skirts. I have four pairs of lace-up, casual sneakers. All four pairs are made by 

miniskirts, jeans, and summer dresses.

Exercise Sneakers

This kind of sneaker is made especially for exercise. There are a lot of 

each kind is made for a particular kind of workout. 

Running Shoes. I like to wear lightweight sneakers for running. My ru

have almost no padding.  

This is a Level 1 heading, so it is centered, bold, and title case.

This is a Level 2 heading, so it is aligned 
left, bold, and title case. Since we must 
use at least two of each level of heading, 
another Level 2 heading might be San-
dals. This would divide Casual Shoes 
into two subsections.

Your title should be bold and centered. 

This is a Level 3 heading, so it is aligned 
left, bold, italic, and title case. 

Note that the paragraph begins right after 
the period of Level 4 headings.

Section Labels [2.14, 2.28]
Section labels like the Abstract, Reference list, and Appendix titles are not considered  
headings. These labels should be centered and bolded. If headings are used within an  
appendix, follow heading guidelines. 

Since every paper starts with an introduction, APA Style does 
not include a heading for the introduction; however, your 
instructor may require one. On the other hand, you should 
include a Level 1 heading for your conclusion since it is  
needed to indicate a division from the previous heading.

Do I need a 
heading for my 

introduction & 

conclusion?
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Orphan Headings
Headings that stand alone on a line can get separated from their text when they are at the 
bottom of a page. Most people prefer to avoid them. 

Indents [2.24]
Indent the first sentence of each paragraph 0.5 inches (one Tab space).  All other lines of the 
paragraph wrap to the left margin. Indent block quotes (40 words or more) 0.5 inches on the 
left side only. Do not indent the first line of the quote. For example:

music on cell phones, and checking in with parents on Facebook. Bucksch et al. (2016) discussed the 

normalization of screen-time behaviors: 

	Clearly, screen time behaviors (STBs) form an important part of young people’s leisure 

time. With continuous technological advances, the choice of innovative and attractive 

devices supports high levels of screen time [...]. The availability of screens, ready access 

to the Internet, and the increasing importance of social media in young people’s lives has 

normalized STBs across the world. (p. 422)

This block 
quotation is 
indented 0.5 
inches.

Grammar Help
Check out these resources for additional help

Commas
Semicolons and Colons
Subject-Verb Agreement

Parallel Structure
Clauses and Phrases

Line Spacing [2.21]
Double-space all lines in the paper, including Reference list entries and block quotes, unless 
your instructor specifies otherwise.  The first line of each page (except the title page)  
begins at the top margin.  Maintain one double space after headings and between  
paragraphs. Use the double-space setting; do not double-space manually by pressing the 
Enter key twice between lines.

Margins [2.22]
Set margins at 1 inch on all sides unless instructed otherwise. (Check the default setting 
which may not be 1 inch.)

Page Numbers [2.18]
Count the title page as page 1 of the document. Place page numbers at the top right corner, 
0.5 inches from the top (inside the header). 

https://write.smumn.edu/wp-content/uploads/2020/08/Commas.pdf
https://write.smumn.edu/wp-content/uploads/2020/08/Semicolons-and-Colons.pdf
https://write.smumn.edu/wp-content/uploads/2020/08/Subject-Verb-Agreement.pdf
https://write.smumn.edu/wp-content/uploads/2020/08/Parallel-Structure.pdf
https://write.smumn.edu/wp-content/uploads/2020/08/Clauses-and-Phrases.pdf
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Spacing after Punctuation [1.54] 
Insert one space after every mark of punctuation. An exception is inside quotation marks and 
parentheses, where there shouldn’t be a space. When typing an em dash or en dash, put no 
space either before or after them. To create an em dash, use two hyphens. To create an en 
dash, type a single hyphen (again, with no space before or after). Note the following  
examples:

The goal of this study—to find a student-centered approach to classroom management—changed during the 

observation process due to administrative “concerns,” though researches disagreed on what that term meant 

(Smith, 2012). 

This is an em dash and is used to 
set off a parenthetical idea. 

This is an en dash (hyphen) and is most often used to connect two words when 
they are being used as an adjective.

There aren’t spaces between the text and quotation marks or paren-
theses. Note that a comma goes inside the quotation marks and that 
a period comes right after the parenthesis.  

Title Page [2.3]
A title page is required (unless your instructor or assignment sheet indicate otherwise).  
Some programs have their own title page requirements. Please follow title page templates 
posted on the Writing Center’s website here.

� 1

The Effects of Screen Time Behaviors on Adolescents

 

Sally Student

Saint Mary’s University of Minnesota

PSY690 Early Childhood Development 

Sam Smith, Instructor 

May 4, 2020

Your name

The name of the class

Your instructor’s name

The date of submission

The name of the university and school

The title of your paper should 
be 3 or 4 lines from the top of 
your page. Note that it should 
be centered, bold and title 
case, which means that you 
should capitalize all major 
words. Press Enter twice 
after your title. 

Use your instructor’s preferred title.

https://write.smumn.edu/home/apa/
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Titles: Formatting  [6.17, 6.18, 9.18, 9.19, 9.20, 9.21)]
There are different rules for formatting titles within your essay and on your Reference list. 
First, you’ll need to know the difference between sentence and title case:

•	 Sentence case means that you capitalize like a sentence, so you would only  
capitalize the first word, proper nouns, and words after a colon. 

•	 Title case means that you capitalize all words except conjunctions, articles, and 
short prepositions (fewer than four letters). 

The chart below outlines the differences for commonly used titles:

On Your Reference ListIn Your Essay

Books 

Articles 

Title Case, Italics: Becoming a Critically Reflective 
Teacher

Title Case, Quotation Marks: “Learning Doesn’t 
Occur in Rows: An Immersive Model for Teaching 
Gender”

Sentence Case, Italics: Becoming a critically 
reflective teacher

Sentence Case: Learning doesn’t occur in rows: 
An immersive model for teaching gender

Webpages Title Case, Quotation Marks: “Teens ‘Not  
Damaged by Screen Time,’ Study Finds”

Sentence Case: Teens ‘not damaged by screen 
time,’ study finds

Journals Title Case, Italics: Journal of Adolescence Title Case, Italics: Journal of Adolescence

Using Bullets [6.52]
The APA Manual allows the use of bullets, rather than numbers, for vertical lists when the 
order of items is not a factor. Bulleted lists summarize. Items in bulleted lists must be  
grammatically parallel, and bulleted lists are double-spaced like the rest of the text.

Using Numbers in a List [6.51]
Use numbers instead of bullets when the order of the items is important—for example, in 
presenting a set of ordered steps in a process.  

Using Lettered Series Within a Paragraph or Sentence [6.50]
When a series or list of items appears within a sentence or paragraph, the items can be—but 
don’t have to be—designated by letters in parentheses. Either of the following sentences are 
acceptable options: 

Researchers divided participants into four groups on the basis of age, gender, height, and weight (Johnson et al., 

2014). The participants were given (a) the trial medication, (b) no drugs, or (c) a placebo (Johnson et al., 2014).
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Tables and Figures [7.1-7.21]

Where to Put Tables and/or Figures
Use tables and figures sparingly and only if the information contained in them is essential for 
understanding the text of your paper. You can place tables/figures within your essay or in an 
appendix after your Reference list, but you must mention the table or figure at the  
appropriate point in your essay like in the following examples:  

As shown in Table 2, the results were....

The configuration of parts (see Figure A1 in Appendix A) depended upon....

How to Number Tables and/or Figures
Assign numbers to tables or figures in order of their appearance in the text, and number 
them separately from one another (i.e., Table 1 or Figure 1). The number should be bold. If 
the table or figure appears in an appendix, the appendix letter appears before the number 
of the table or graph (e.g., Figure A1 would be the first or only figure in Appendix A).   

How to Cite Tables and/or Figures
You should always obtain copyright permission to use tables and figures from another source 
in your own paper; however, we suggest checking with your instructor/advisor/program for 
specific recommendations. At the very least, you should include a citation of where you got 
either the table/figure or information that allowed you to create your own table/figure. This 
would appear in the “Note” section of your table/figure (p. 7). Here are some examples of 
common types of citations for tables/figures: 

Creating Your Own Table or Figure

Source(s) Used in 
your Paper

Reprinting a Table or Figure Directly

Note. Adapted from “Changes in Physical Activity and Screen Time Related to Psychological 

Well-being in Early Adolescence: Findings from Longitudinal Study ELANA,” by V.S. Straat-

mann, A.J. Oliveira, M. Rostila, and C.S. Lopes, 2016, BMC Public Health, p. 6 (doi:10.1186/

s12889-016-3606-8).

Note. Data on screen-time behaviors from Bucksch et al.(2016), Straatmann et al. (2016), and 

Trinh et al. (2015). 

Note. Reprinted from “A Snapshot: Diabetes in the United States,” by CDC, n.d., Retrieved from https://www.cdc.gov/dia-

betes/pdfs/library/socialmedia/diabetes-infographic.pdf

Source Not Used in 
your Paper

No entry is needed on the Reference list unless that source was cited elsewhere in the paper.  
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Tables and Figures [7.1-7.21], continued

Sample Table

Table 1

Title of Table

Begin text here. 3.12 4.62 8.17

Use TAB to move from one table 
cell to the next. 5.86 2.13 9.87

Use as few lines as possible, and 
never use vertical lines. 6.89 4.21 3.20

You may single space and change 
the font to differentiate it from the 
rest of your essay. 

4.78 5.46 3.21

Note. Any notes necessary to explain the table or to identify the source of the 

information used in the table should be placed here, preceded by the label 

“Note” as shown (see p. 6). 

Your title should be specific enough for your reader to know 
what is presented in your table but should not repeat informa-
tion in the table itself. 

3rd column 
heading

4th column 
heading

2nd column 
heading

1st column 
heading

Column headings should be 
sentence case (see p. 5) and 
not bold. 

This table uses a sans serif 
font for both clarity and to 
differentiate it from Times 
New Roman, which is used in 
the rest of the essay. 

Only use horizontal borders 
(lines) if they are necessary, 
which is usually only under 
the title, under the headings, 
and above the note. 

Sample Figure

1

 Series 3

 Series 2

Category 4Category 3Category 2Category 1

Note. You should also include a caption like this, which gives a description 

of the figure and any additional information needed to understand it. 

2

3

4

5

Figure 1

Title of Figure

Y-
ax

is
 T

itl
e  Series 1

X-axis Title

Use high contrast colors within 
your figure. Grayscale is often 
the best option when printing in 
black and white. 

This is where you would  
include any citation  
information if you are  
reproducing an image 
found elsewhere. See 
samples 7.14, 7.21, and 
7.3 in the APA Manual. 

The titles within the figure should be title case (p. 5). 
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Part Two: Crediting Sources

Where and Why We Credit Sources
Sources are credited both within your essay in in-text citations and at the end of your  
essay on the Reference list. You need to credit sources for several reasons, and  
understanding these reasons will help you to know what sources to cite and how to  
document them. 

Academic Ethics: Honesty and fairness require you to let your readers know whose 
words or ideas you have borrowed. Even when you put a direct quote in your own 
words by paraphrasing, you are still obligated to identify the source. 

Scholarly Credibility: All research is founded on or related to previous scholarly work. 
Therefore, you need to relate your ideas to what has been written before. Crediting 
this previous work establishes your credibility and provides context for your ideas.  

Source Retrieval: For various reasons, readers may want to view the sources you used 
in a piece of writing.  You are responsible for providing sufficient documentation in a 
systematic way (e.g., in APA Style) so that readers can retrieve the information being 
used. 

An appendix is a document that you attach at the end 
of your paper rather than including within the body of 
your paper because the information is helpful to your 
paper but not necessary to include in your text.  
Common appendices are lists of interview questions, 
extensive tables, and sample worksheets.

Your appendices begin after your Reference list. Each appendix should 
begin on a new page with an appropriate title (Appendix A, Appendix B, 
Appendix C, etc.). The title should be centered, title case, and bold. If 
you have only one appendix, label it Appendix. When you mention the 
appendix within your essay, you should refer to it in the sentence like 
this:

See the list of interview questions in Appendix A. 

A questionnaire was developed to identify these common traits 
(see Appendix B). 

How do I  
format my  
appendices?



9

How to Begin
Compose your Reference list as you do your research for the following reasons:

1.	 Creating the APA Reference list entry helps you understand your source—who wrote it, 
when it was published, and who published it.

2.	 When you compose your Reference list entry, you will recognize if a crucial piece of 
source information is missing.  You can then decide whether to locate the missing 
information or avoid using the source.

3.	 You will know how to cite the source in the body of your paper.  The first two  
elements of the Reference list entry (author name and date) tell you how to write the 
brief citation in your paper.  

Primary and Secondary Sources [8.6]
A primary source is the originator of the information—the source in which the information 
was first expressed or published.  Sigmund Freud, for example, was the primary source for 
the information in his work, Civilization and Its Discontents, written in 1930.  

However, you almost certainly did not read that book because it was published in Europe and 
written in German.  Unless you are an advanced student or practitioner, you probably read 
about Freud’s work in another publication—a textbook or other book like Breger’s A Dream 
of Undying Fame: How Freud Betrayed His Mentor and Invented Psychoanalysis. In this case, 
Breger is a secondary source for Freud’s ideas. 

When to Use Secondary Sources
Use secondary sources when the primary source is not translated into English, when you 
need to discuss reviews of the primary source material, or when the primary source  
information is not essential to your purpose. In all other circumstances, avoid secondary 
sources when possible.  When you rely on a secondary source, you raise the question of why 
you didn’t seek the original.  Furthermore, you are forced to rely on the interpretation of 
the secondary source author.    

The chart below shows the differences in both Reference list entries and in-text citations for 
primary and secondary sources.

In
-t

ex
t 

 
Ci

ta
ti

on
Re

fe
re

nc
e 

 
Li

st
 E

nt
ry

Primary Source

Freud, S. (1930). Das unbehagen in der kultur. 	  

	 Internationale Psychoanalytischer Verlag. 

Freud (1930) said....

... (Freud, 1930). 

Secondary Source

Breger, L. (2009). A dream of undying fame: How  

	 Freud betrayed his mentor and invented  

	 psychoanalysis. Norton. 

Freud (as cited in Breger, 2009) said....

... (Freud, as cited in Breger, 2009).  



10

Reference List
 

Reference List Format
Your Reference list should have the same margins and font as the rest of your paper. Here 
are some other formatting tips:

Do Don’t
•	 Start your Reference list on a new page 

following the last page of your essay (and 
before any appendices). 

•	 Double-space your entries. 
•	 Alphabetize your entries (see p. 43). 
•	 Use a hanging indent (see p. 41). 

•	 Include extra spaces between entries. 
•	 Use bullets or numbers for your entries. 
•	 Copy and paste from a database without 

checking for correctness (see p. 38). 

Click here to see how to cut and paste entries from a database like SuperSearch.

Reference Entry Basic Format [9.4] 
APA Style is easier to learn when you recognize patterns of rules.  Instead of trying to  
remember dozens of individual examples, learn the four basic elements that comprise all 
source references: author, date, title, and publisher. 

Element 1: The  Author Element [9.7-9.12]
The author may be a single individual, several individuals working in collaboration, an  
organization, a corporation, a government agency, or other group.  Place a period at the end 
of the element, regardless of the type of author. The following are examples of author  
elements:  

American Cancer Society. 

Ferris, D. 

Internal Revenue Service. 

West, S., Beckman, T., Vonk, J., & Jett, S. E.  

Organization

Individual

Government Agency
Individuals in collaboration/
co-authors

In the rare case in which the author of a source is not identified, move the work’s title into 
the author position and alphabetize by the first word of the title in place of the author’s 
name. Click here to see an example. 
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Personal communications can include e-mails, 
personal interviews, and telephone conversations. 

Personal communications are not retrievable 
sources so are not included on the Reference list. 
However, they must be cited in the text as follows:  
(J. Doe, personal communication, April 

10, 2012).  If the name of the person being cited is written into the 
running text, then it need not appear again in the parentheses.

How do I cite 

personal  
communication?

Reference Entry Basic Format [9.4], continued

Element 2: The Date Element [9.13-9.17]
The date is usually expressed as the year of publication and is placed in parentheses after 
the author element. However, if a month and day are provided—and if no volume number is 
given—include the month and day after the year.  The date element cannot be left blank.  If 
no publication year is provided, type the letters n.d. inside parentheses.  Place a period at 
the end of the date element.  Here are examples:

(2016). 	

(2012, May 19).  	

(n.d.).  

Year of publication
Month and day provided by 
publisher, but no volume 
number provided.

No publication date was provided by the publisher or website.

Element 3: The Title Element [9.18-9.22]
Click here to see a chart with more information on how to capitalize and format titles. 

Evaluating public programs with close substitutes: The case of Head Start. 

Focus groups as qualitative research (2nd ed.). 

Writing across borders: Students have their say [Video webcast].  

Title with form of work bracketed

Book title including edition number

Article published in the journal 
Quarterly Journal of Economics

In titles, include subtitles as shown above. Include editions, volume numbers, or report 
numbers inside parentheses as shown above. In brackets, indicate the form of work (e.g., 
brochure, motion picture, audio podcast) if the form varies from ordinary print or electronic 
print media. 
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Reference Entry Basic Format [9.4], continued

Element 4: The Publisher Element [9.23-9.37]
The fourth element, publisher, varies according to type of source.  

Alcoholics Anonymous. (1972). A brief guide to Alcoholics Anonymous.   

https://www.aa.org/assets/en_US/p-42_abriefguidetoaa.pdf

Lambert, S. (2011). Sustainable leadership and the implication for the general 

further education college sector. Journal of Further & Higher Education, 

35(1), 131-148. https://doi.org/10.1080/0309877X.2010.540319

Salkind, N.J. (2017). Statistics for people who (think they) hate statistics (6th 

ed.).  Sage. 

For a webpage, the 
publisher information 
element is the  
document’s URL 
(include the  
hyperlink). 

For a book, the publisher element is the  
publisher’s name.

For a journal article, the 
publisher information 
element contains: Title of 
journal, volume number, 
issue number (if provided), 
page number range, and 
DOI number (if provided).

Missing Elements [Author, 9.12; Date, 9.17; Title, 9.22, Source, 9.37]
What happens if one of the four elements is missing?  First, try to find the source in an  
academic database, where the reference information is likely to be complete. Otherwise, 
adjust as follows: 

•	 Missing author: If the author’s name is not provided, move the title to the author 
position (that is, to the beginning of the reference) and alphabetize the reference by 
the title (skipping the words The, A, or An at the beginning of the title). See example 
on p. 15. 

 
•	 Missing publication date: If the publication date is missing, use the abbreviation n.d. 

inside parentheses in the place of the date, both in the Reference list entry and in 
the in-text citation. See example on p. 15.

•	 Missing title: Give a short description inside brackets where the title would normally 
be, like this [Letter to the editor]. This case would be highly unusual, and you should 
check to ensure the source is reputable. 

•	 Missing publisher information: If the publisher information given is not sufficient to 
allow readers to retrieve the source, then do not use the source.  If the source is 
an unpublished one, give that information after the title. For example: Author, X. 
(Year). Title. Unpublished manuscript.

https://doi.org/10.1080/0309877X.2010.540319
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Reference List Examples: Print Sources

Book

 Lazear, D. G. (1994). Multiple intelligence approaches to assessment: Solving the assessment 	

	 conundrum. Zephyr Press.

This is usually the publishing company, but if the author and publisher are the same, use the word 
Author for the publisher name: American Psychological Association. (2020). Publication manual of 
the American Psychological Association (7th ed.). Author.

Capitalize only the first word, proper nouns, and the first word following a colon.

Book, Translated

 Freire, P. (2000).  Pedagogy of the oppressed (M. F. Ramos, Trans.). Continuum. (Original work 	

	 published 1972)

Provide the translator’s name after the title. 

Chapter in an Edited Book

 Murphy, R. P., & Urquhart, A. T.  (2010).  Sexuality in the headlines. In K. P. Murphy & J. L. 	

	 Pierce (Eds.), Queer Twin Cities (pp. 45-80). University of Minnesota Press.

Place the authors of the chapter at the beginning. Do not invert the editors’ names (i.e., initials 
precede the last name). 

Periodical Article: Journal

 Rowley, C., &  Ingyu, O. (2016). Business ethics and the role of context: Institutionalism,  

	 history, and  comparisons in the Asia-Pacific region.  Asia-Pacific Business Review, 	

	 22(3), 353-365. 

For multiple authors, separate each author with a comma. Use an ampersand (&) before the last author. 

The article title should be sentence case (see p. 5). 

Periodical Article: Newspaper

 Carey, B.  (2017, January 2). ‘Fake news’: Wide reach but little impact, study suggests. The 	

	 New York Times, D5. 

Give the full date: year, month, day. 

Provide all page numbers, including section letter, on which the article appears. 
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Reference List Examples: Digital Sources

Webpage or Document From a Website

 Bagci, F., & Alrashed, E.A. (2016). Security architecture for wireless sensors. WSEAS trans-

	 actions on communications. WSEA.  http://www.wseas.org/multimedia/journals/ 

	 communications/2016/a325804-887.pdf Include the hyperlink to the URL. 

Webpage titles should be sentence case (see p. 5) and in italics. 

Webpage With No Author 

 Mayo Clinic. (2015, August 20). Artificial sweeteners and other sugar substitutes: Bewildered 	

	 by the variety of sugar substitutes available these days? http://www.mayoclinic.org/	

	 healthy-lifestyle/nutrition-andhealthy-eating/in-depth/artificial-sweeteners/art-20046936 

If no author is listed, then you should look for an organizational author. If the author 
and website title/name are the same, it’s not repeated in the source element. 

 
Webpage With No Author or Organizational Author

 Which artificial sweetener is right for me? (n.d.). Diabetes.co.uk. https://www.diabetes.co.uk/	

	 sweeteners/which-artificial-sweetener-is-right-for-me.html

If no author or organizational author is listed, begin with the title of the webpage. 

Since the title of the webpage and 
the title/name of the website are  
different, the title/name of the  
website appears here.

Webpage With No Date

 Harvard Health Publications. (n.d). Cutting back on added sugar.  https://www.health.harvard.	

	 edu/staying-healthy/cutting-back-on-added-sugar

If no date is listed, then you should use the abbreviation “n.d.” for “no date.” 

http://www.wseas.org/multimedia/journals/communications/2016/a325804-887.pdf
http://www.wseas.org/multimedia/journals/communications/2016/a325804-887.pdf
https://www.mayoclinic.org/healthy-lifestyle/nutrition-and-healthy-eating/in-depth/art-20046936
https://www.mayoclinic.org/healthy-lifestyle/nutrition-and-healthy-eating/in-depth/art-20046936
https://www.diabetes.co.uk/sweeteners/which-artificial-sweetener-is-right-for-me.html
https://www.diabetes.co.uk/sweeteners/which-artificial-sweetener-is-right-for-me.html
https://www.health.harvard.edu/staying-healthy/cutting-back-on-added-sugar
https://www.health.harvard.edu/staying-healthy/cutting-back-on-added-sugar
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Reference List Examples: Digital Sources, continued

DOI numbers [9.3, 9.4, 9.35, 10.1]
DOI is an abbreviation for Digital Object Identifier, a unique set of characters assigned to 
identify a source so that it is searchable on the Internet.  Most, but not all, databases now 
assign DOI numbers to sources. In some databases, the DOI appears in the short citation; in 
others, you must click on the source title to obtain the DOI. Within your Reference list  
entries, the DOI should be formatted as a hyperlink (https://doi.org./10....).

The instructions below explain how to use a DOI to find a source on the Internet. If the DOI is 
long, you can use http://shortdoi.org to shorten it. 

1.	 Go to your web browser and type the 
following on the address line: dx.doi.org. 

2.	 When the DOI page opens, type or copy 
the DOI and then click Go.  

Journal Article from a Database

Johnson, K.C. (2017). Citizenship versus the new civics. Academic Questions, 30(2), 134-164. 

https://doi.org/10.1007/s12129-017-9627-7 If no DOI or accessible link to the article (on the  
publisher’s website, for example) is available, end the 
citation with the period after the page range. 

ERIC (Educational Resources Information Center) Online Resources 
ERIC contains mostly citations and abstracts, not full text documents. If you cannot retrieve 
the full text document from ERIC and instead order it through a librarian or other provider, 
cite it like any other source of its type, without mention of ERIC.

 Miller, D. C., Sen, A., Malley, L. B., & Burns, S. D. (2009). Comparative indicators of educa-	

	 tion in the United States and other G-8 countries: 2009 (ED504634). ERIC. https://files.	

	 eric.ed.gov/fulltext/ED504634.pdf

http://shortdoi.org/
https://doi.org/10.1007/s12129-017-9627-7%20
https://files.eric.ed.gov/fulltext/%0A%20%20%20%20%20%20%20%20%20%20%20ED504634.pdf
https://files.eric.ed.gov/fulltext/%0A%20%20%20%20%20%20%20%20%20%20%20ED504634.pdf
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Reference List Examples: Digital Sources, continued

Course Materials (PowerPoint slides, lecture notes, handouts, etc.) 

Smith, B. (2019). Understanding taxes [PowerPoint slides]. https://courses.smumn.edu/web-	

	 apps/portal/execute/tabs/tabAction?tab_tab_group_id=_199_1

Smith, B. (2019). Taxes and the medical industry [Handout]. https://courses.smumn.edu/web-	

	 apps/portal/execute/tabs/tabAction?tab_tab_group_id=_199_1

Include the type of source within brackets after the title.

If the document is within a system that you must log into  
(like Canvas), then the URL should be to the general 
login page and not to your course page. 

This author should be your instructor’s name 
unless otherwise noted in the document.

TED Talk, YouTube, or Other Streaming Video

Crenshaw, K. (2016, October). The urgency of intersectionality [Video]. https://www.ted.com/	

	 talks/kimberle_crenshaw_the_urgency_of_intersectionality

 
Blog Post

Fogarty, M. (2017, August 24). ‘Important’ or ‘Importantly’?  [Web blog post]. http://www.	

	 quickanddirtytips.com/education/grammar/important-or-importantly 

The title is not italicized because it is part of a larger blog series called Grammar Girl. The single quotation 
marks are from the source.

Reference List Examples: Other Sources

Motion Picture

Baumbach, D. (Director). (2005). The squid and the whale [Film]. Samuel Goldwyn Films.

You can describe the source form in brackets. If you watched it on DVD, for 
example, you would use [DVD].

https://courses.smumn.edu/webapps/portal/execute/tabs/tabAction%3Ftab_tab_group_id%3D_199_1
https://courses.smumn.edu/webapps/portal/execute/tabs/tabAction%3Ftab_tab_group_id%3D_199_1
https://courses.smumn.edu/webapps/portal/execute/tabs/tabAction%3Ftab_tab_group_id%3D_199_1
https://courses.smumn.edu/webapps/portal/execute/tabs/tabAction%3Ftab_tab_group_id%3D_199_1
https://www.ted.com/talks/kimberle_crenshaw_the_urgency_of_intersectionality
https://www.ted.com/talks/kimberle_crenshaw_the_urgency_of_intersectionality
https://www.quickanddirtytips.com/education/grammar/important-or-importantly
https://www.quickanddirtytips.com/education/grammar/important-or-importantly
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Legal Documents [11.1-11.10]

Legal documents are cited in a different way, so you should consult the APA Manual, other 
resources, or Writing Center staff for help. Here are some of the legal documents students 
use most often with examples and tips for citing them both in your essay and on your  
Reference list.

American Association for Marriage and Family Therapy Code of Ethics

American Association for Marriage and Family Therapy. (2001, July 1). AAMFT code of ethics. 	

	 https://www.aamft.org/Legal_Ethics/Code_of_Ethics.aspx

Parenthetical in-text citation: ...(American Association for Marriage and Family Therapy, 2001). 
Narrative in-text citation: American Association for Marriage and Family Therapy (2001)....

Court Cases

Brown v. Board of Education, 347 U.S. 483 (1954). https://www.oyez.org/cases/1940-1955 

	 /347us483

Use “v.” for court cases instead of “vs.”

Parenthetical in-text citation: ...(Brown v. Board of Education, 1954).
Narrative in-text citation: Brown v. Board of Education (1954)....

Oyez.org is a repository 
for all Supreme Court 
cases.

Federal Laws

Americans With Disabilities Act of 1990, 42 U.S.C. § 12101 et seq. (1990). https://www.ada.	

	 gov/pubs/adastatute08.htm

Make the section symbol by pressing Alt and typing in 0167 or going to Insert, Symbol. See p. 37.

Parenthetical in-text citation: ...(Americans With Disabilities Act of 1990, 1990). 
Narrative in-text citation: Americans With Disabilities Act of 1990 (1990)....

https://www.aamft.org/Legal_Ethics/Code_of_Ethics.aspx
https://www.ada.gov/pubs/adastatute08.htm
https://www.ada.gov/pubs/adastatute08.htm
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APA Help
Check out these resources for additional help

APA Templates

Citing Webpages

APA Style Blog

APA FAQs for Reference List

Other resources:

SMUMN resources:

APA FAQs for In-text Citations

Legal Documents [11.1-11.10], continued

Minnesota Statutes, including Board of Marriage and Family Therapy Code of Ethics
The APA Manual suggests using The Bluebook to format entries for state statutes; however, 
this is a very specialized citation style that also doesn’t include retrievable links for sources, 
so we suggest using the format below. Of course, you should check with your instructor/ 
program/assignment sheet for specific requirements. 

The Office of the Revisor of Statutes has published a guide on how to cite various Minnesota 
state laws. You can find this guide here: https://www.leg.state.mn.us/leg/faq

 Minnesota Statutes 2019, section 125A.02, subdivision 1, online. Accessed December 5, 2019. 

The section and subdivision numbers can 
be found on the webpage for the statute as 
indicated below. 

The date you accessed the webpage. 

https://write.smumn.edu/home/apa/
https://write.smumn.edu/wp-content/uploads/2020/08/Citing-Webpages.pdf
https://apastyle.apa.org/blog/
https://write.smumn.edu/wp-content/uploads/2020/08/APA-FAQs-References.pdf
https://write.smumn.edu/wp-content/uploads/2020/08/APA-FAQs-In-text-Citations.pdf
https://www.leg.state.mn.us/leg/faq/
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In-text Citations

Purpose of Citing in Your Paper
A citation is a “note” within your paper that lets your reader know where the information 
came from. You must include an in-text citation for all exact quotations and paraphrases 
taken from sources and also cite all information that isn’t common knowledge. 

“Common knowledge” doesn’t have a universal definition, so we suggest erring on the side 
of finding (and citing) support for all claims, controversial stands, specific facts, etc. The  
table below gives you some guidelines on what may and may not be “common knowledge,” 
but you will need to use your best judgement and/or ask for clarification from your  
instructor or Writing Center staff as needed.  

All citizens are guaranteed public 
education from kindergarten to 
twelfth grade.

The IDEA guarantees special  
education services to those  
students who need them.  

Leading is different than  
managing. 

Good leaders build strong  
interpersonal relationships with 
their employees. 

Meditation is a well-known  
mindfulness strategy. 

Meditation has been shown to 
reduce blood pressure. 

It is imperative to maintain stable 
hemodynamics during surgical 
procedures.

One in three Americans has high 
blood pressure. 

There are many different kinds of 
learning strategies. 

Active learning has been shown to 
impact knowledge retention more 
than other learning strategies. 

Probably Common Knowledge Probably Not Common Knowledge

Most people wouldn’t know 
what this specific law is. 

These are claims that  
someone might disagree 
with.  

This is a claim that someone 
might disagree with.  

This is a specific statistic.

Don’t press Tab or  
Enter to center your 
text. There are two 
ways to align your  
text (see p. 31, too), but this is the quickest. First, 
highlight the text you want to center. Then click 
the Center button as shown above. 

How do I center 

my title or  
headings?

Left

Center

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20to%20Set%20Paragraph%20Alignment%20-%20Storyline%20output/story.html
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In-text Citation Basics
In APA Style, the in-text citation should be the author and date of the source because this 
enables the reader to easily locate the source’s entry on your Reference list. You can see this 
connection below: 

Paragraph from the essay: 

Because of the increasing use of  

technology, the evidence is clear that STBS 

are increasing worldwide. Over 65% of  

adolescents exceed the recommended 

amount of screen time per day (Straatmann 

et al., 2016; Suchert et al., 2016).  Similarly, 

Bucksch et al. (2016) found the STBs for 

adolescents increased two hours per day 

from 2002 to 2010 even while some experts 

recommend less than two hours of total 

screen-time per day. While it’s clear that 

STBs are increasing, it’s less clear if these 

behaviors are overall negative or positive. 

11

References

Bucksch, J., Sigmundova, D., Hamrik, Z., Troped, P. J., Melkevik, O., Ahluwalia, 	

	 N., & ... Inchley, J. (2016). International trends in adolescent screen-time 	

	 behaviors from 2002 to 2010. Journal of Adolescent Health, 58(4), 417-	

	 425. https://doi.org/10.1016/j.jadohealth.2015.11.014

Straatmann, V. S., Oliveira, A. J., Rostila, M., & Lopes, C. S. (2016). Changes in 	

	 physical activity and screen time related to psychological well-being in 	

	 early adolescence: findings from longitudinal study ELANA. BMC 		

	 Public Health, 161-11. doi:10.1186/s12889-016-3606-8

Suchert, V., Hanewinkel, R., & Isensee, B. (2016). Screen time, weight status 	

1

1 2

2

3

3

A reader would look at the Straatmann et al. citation (     ) and know that in order to learn 
more about this source, they could look on the Reference list under Straatmann. 

If there is no named author, you would use the first element that appears in the Reference 
list entry (see example here), which would be either an organizational author (e.g., World 
Health Organization) or a title. You should put the title into either italics (books) or quota-
tion marks (articles or webpages) as appropriate. 

If the title is long (more than about 4-5 words) you should shorten it using common sense 
(e.g., “Dr. Dweck’s Research into Growth Mindset Changed Education Forever” should be-
come “Dr. Dweck’s Research” or “Dr. Dweck’s Research into Growth Mindset” but not “Dr. 
Dweck’s Research Into.” 

The only exception to this would be sources that aren’t included on your Reference list like 
personal communication (click here for more information). 

2
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Where and When to Cite? 
Two frequent APA questions are: How often should I cite and where should I cite? The  
answers depend on how you are using the sources. You can cite using running text or  
parenthetical citations:

Currently, most teens do not get the recommended amount of moderate to vigorous physical activity (MVPA) 

every day (Straatman et al., 2016). The trend of decreasing physical activity led Bucksch et al. (2016) to 

demand “interventions for this population” (p. 421).  	  

To cite parenthetically means to place the author’s name inside parentheses along with the date (and page number, if used). 

To cite in running text means to place the author’s name in the 
sentence without parentheses (always place the date and page 
number in parentheses). 

When synthesizing ideas from multiple sources, it is usually better to cite at the end of the 
sentence like this: 

Transformational leaders are recognized as those who inspire their followers to higher levels of performance 

and change (Bass & Avolio, 1993; Burns, 1978; Yukl, 1994). 

Remember that when multiple sources are in the same citation, they should 
be put in alphabetical order and separated by a semicolon.

Placed in parentheses at the end of a sentence, citations are less distracting to the flow of 
ideas. In the example above, the focus is on the assertion the writer is making and not on 
the sources. 

However, sometimes you might focus on one source and a paragraph might contain ideas 
from only one author. In this case, it’s better to introduce the author’s name into the  
running text, where it is more noticeable, because you are now discussing or summarizing 
the author’s work. Note the following example:

	 Pounder (2009) assumed that a university classroom could be considered analogous to an  

organization, with the professor as a leader and students as followers.  Pounder concluded that a  

transformational teaching style leads to positive student learning outcomes.  Students with  

transformational teachers are motivated to work harder (Pounder, 2009). Provide the name and date 
every time in parenthetical 
citations. 

According to the APA Manual [6.11], you do not need to include the date when the name of the 
author appears in the same paragraph within the narrative of your sentence like this as long as 
it can’t be confused for another author; however, we recommend citing the date every time for 
clarity. Ask your instructor what they prefer. See p. 21 for more information.

In the example above, the focus is on Pounder’s work, and putting the citation in the  
running text makes that evident. 
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Signal Phrases
When using running text citations, it’s best to use a variety of signal phrases to avoid  
repetition. Here are some examples: 

Stieglitz and Hernandez (2002) emphasized that....

Three earlier studies (Gudmund, Farrar, & McDermot, 2004; Willum, 2000; Wright & Formani, 
2006) were inconclusive....

According to Khali and Kozumi (2000), earlier research failed to....

Zarweit (2007) responded, “At no time were the subjects informed” (p. 92).

Czel (1999) defined sensation seeking as behavior that....

Note that each example here uses past tense 
when referring to sources. 

Use a comma 
after a running 
text citation 
when there is 
an introductory 
phrase or an 
attribution like 
“stated” but not 
if there isn’t. 

Essay Help
Check out these essay resources for additional help

Paragraph Organization
Essays 101
Revising Checklist
Reverse Outlining

Citing Works by Multiple Authors (using “et al.”)
The table below explains how to cite sources with three or more authors in running text and 
parenthetical citations using the phrase “et al.” which means “and others.”

One or Two  
Authors

Three or More 
Authors

... (Matsuda & Silva, 2005).

Parenthetical Citation

... (Bucksch et al., 2009). Bucksch et al. (2009) said...

Running Text Citation

Matsuda and Silva (2005) said...

Note that there is a period after “al.”

https://write.smumn.edu/wp-content/uploads/2020/08/Paragraph-Organization.pdf
https://write.smumn.edu/wp-content/uploads/2020/08/Essays-101.pdf
https://write.smumn.edu/wp-content/uploads/2020/08/Revising-Checklist.pdf
https://write.smumn.edu/wp-content/uploads/2020/08/Reverse-Outlining.pdf
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Quoting and Paraphrasing

Quoting [8.25-8.36]
Use direct quotes sparingly. Quoting does not indicate how well, or even if, you understand 
the material you are quoting.  Overuse of quotes, therefore, can cause you to lose credibility 
with your readers.  Quoting can also disrupt the flow of your writing; suddenly encountering 
another person’s writing style can be jarring to readers.

If you do quote, have a good reason to do so. For example: 
• to discuss the way an author expressed his or her ideas,
• to present a controversial or disputed statement verbatim,
• to convey precise technical data or directions,
• to produce a rhetorical effect when introducing or emphasizing a point.

Quoted text of fewer than 40 words must be enclosed in quotation marks and followed by 
the page number of the original text:

Cheak-Zamora and Thullen (2017) wrote that "education and training for providers is essential to 

ensure they understand the needs of people with DD and/or multiple conditions and are working 

to address quality and access issues" (p. 43).

Quoted text of 40 or more words should be placed in a separate, indented (block) paragraph:

Paterson and Chicola (2017) described their informal mentorship as follows: 

We co-negotiated difficult solutions to problems with our pesky “human” resources; we 

explored structural and governance strategies; and we diffused the challenges in our  

personal lives by talking with an empathetic female ally who was at the same time a  

professional colleague and friend. (p. 36) 

Quotations within a block quotation should be surrounded by 
double quotation marks. 

Also note that the end punctuation occurs 
before the parenthetical citation in block 
quotations. 

Omit the 
quotation 
marks around 
a block  
quotation. 
See p. 3 for 
more  
information. 
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Quoting [8.25-8.36], continued

Integrating Quotations
If the quote is a complete sentence, capitalize the first word. 

According to Li (2016), “Information technology is an important part in Flipped Classroom, which decisively 

influences the depth of the students’ extracurricular learning and the creation of students’ learning environment” (p. 

1962). 

Harris (2000) remarked, “Finding information is an art, not a science” (p. 214).

However, if the quoted text is not a complete sentence or if a quoted sentence follows the 
word “that,” do not capitalize the first word or precede it with a comma.  

Quincy (2000) acknowledged that “negotiations over bride price sometimes involved more than the price of the 

bride” (p. 105).

Do not capitalize the first word of a quoted phrase (i.e., an incomplete sentence).

Bryson (2002) called the English language “a merry confusion of quirks and irregularities that often seem willfully 

at odds with logic and common sense” (p. 1).  

You should not use an ellipsis before or after a phrase taken from a complete sentence. 

Sutter (1998) was fascinated with Lake Superior's ore boats and foreign freighters because they “seemed impossibly 

exotic” (p. 2). 

This is a phrase taken from a complete sentence in the source, but it 
doesn’t need ellipses around it. 

You should use an ellipsis to indicate missing words/sentences from the middle of a  
quotation; however, this would be rare since you shouldn’t be using long quotations in  
general. Click here to see an example. 
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Paraphrasing [8.1-8.24]
A paraphrase is a summary of an idea from a source. A paraphrase should change both the 
words and structure of the original. 

When to Cite Paraphrases
You must cite a paraphrase on the first mention within a paragraph. The APA Manual says you 
may omit citations for consecutive sentences that paraphrase from the same source within 
the same paragraph as long as it is clear that you are paraphrasing. To avoid unintentional 
plagiarism, you should make explicit mention of the author(s) or study in some way. 

Remember that your reader cannot know your intent, so it must be completely clear 
from your writing/citing alone what is and isn't taken from a source. Here is a sample: 

          The evidence is clear that many adolescents exceed the recommended 

amount of screen time. Bucksch et al. (2016) found most adolescents are watch-

ing screens more than two hours per day. These researchers, however, noted 

that while screen-time habits still exceed the recommended amount, there has 

been an overall decrease in STBs in the last few years for adolescents in many 

countries. Other researchers found that over 65% of adolescents exceed the 

recommended amount of screen time per day but did not note a decline (Straat-

mann et al., 2016; Suchert et al., 2016). Perhaps surprisingly, US teens are 

included in the decrease mentioned above. It is clear that most teens still exceed 

the recommended amount of screen time, and there are both risks and benefits 

to these behaviors.

Since this sentence 
follows a cited sentence 
and uses the phrase 
“these researchers,” it 
would likely be clear who 
the source is, so it does 
not need to be cited.

It might not be 
100% clear what 
this sentence is 
referring to, so it 
should be cited. 

Since you can’t know if your reader will be confused and because it’s not incorrect to cite 
every sentence, this is what we recommend in the Writing Center. 

Every assignment is different. Literature reviews, 
for example, might have paragraphs where every 
sentence except the topic sentence and concluding 
sentence have citations. A narrative essay might 
have very few (if any) citations. In general, a body 
paragraph should have a topic sentence that is 
your own summary of the point, 1-2 sentences of 

source support, 2-4 sentences of your own analysis or explanation, 
and a concluding sentence. You can see examples and other  
resources on this topic at www.write.smumn.edu. 

How often 
should I use 

a quotation or 

paraphrase?
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Paraphrasing [8.1-8.24], continued

How to Paraphrase
You have probably heard that paraphrasing involves putting a source in “your own words.” 
Adequate paraphrasing, however, involves more than just replacing words in the original 
with synonyms, or words that are similar in meaning to the original. Successful paraphrasing 
requires you to change not only the words but also the structure of the original passage. We 
recommend reading the passage and then putting the source away to avoid poor paraphras-
ing techniques (i.e., just changing every word to a synonym). 

There are several strategies that you can use to paraphrase your sources. You will need to 
use more than one strategy in order to avoid plagiarism. Here are six strategies: 

#1 Change word form or part of speech 
#2 Change from active to passive voice, or vice versa 
#3 Change the word order 	
#4 Change from specific to general 
#5 Change transitions 
#6 Replace words in the original with synonyms

The process might take several drafts. You can see an example below: 

Original 
Quotation

This can be 
changed from active 
voice to passive 
voice (#2). 

This can be 
changed to a 
synonym (#6).

This can be 
moved to the 
beginning to 
change the 
structure (#3).

From 2002-2010, it was observed that there was a rise in computer use 
(Bucksch et al., 2016, p. 420).

Strategies

Draft 1

Strategies

Draft 2

This could also 
be changed to a 
synonym (#6). 

In the 2000s, a rise in computer use was observed (Bucksch et al., 2016, p. 
420).

“We observed a strong increase in computer use, including nongaming and 

gaming activities, from 2002 to 2010” (Bucksch et al., 2016, p. 420).

This could be moved to the end (#3). 
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Part Three: Using Microsoft Word for APA

Getting Started & General Tips

A Word on APA Format and Instructor Requirements
This section will provide you with instructions on how to format your documents according 
to the requirements and guidelines of APA Style. We will also provide instructions on how to 
format things for which the APA has no requirements, like Tables of Content.

However, every instructor and assignment is different. You should always refer to your  
assignment sheet, program-specific templates, and the instructions given to you by your 
instructor in terms of formatting. 

Before We Start

To get the most out of the instructions that follow, please familiarize yourself with the  
following topics.

Ribbon Bar: The Ribbon Bar is how you will navigate through all of the options in Word. 
The diagram below will familiarize you with the elements of the Ribbon Bar.

Each tab is divided into sections. For example, 
the Home tab is divided into Font, Paragraph, 
Styles, and Editing. 

The Quick Access Toolbar contains  
frequently used tools, including Save and 
Undo. You can add/remove items to this 
toolbar by clicking on the arrow. 

The Ruler lets you adjust the indentation of 
your text. To see the ruler, you might need 
to go to the View tab and check the box next 
to Ruler.

The Ribbon Bar is divided into tabs: Home, Insert, Layout,  
References, Mailings, Review, View, and Help.

https://write.smumn.edu/home/apa/
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Ruler: This tool allows you to indent directly from the main screen. 

Use the upper triangle to indent the first line of a 
paragraph. 

Use the lower triangle to indent subsequent lines 
of a paragraph. Use the square to indent a block of text.

Show/Hide: This function allows you to see hidden formatting codes,  
which is helpful when you need to correct or modify formatting. 

Find this button within the Paragraph section of the 
Home tab. When you press this button, you’ll see all of 
the formatting codes within your essay. 

indicates you pressed Enter. 

Common codes include:

indicates that you pressed the space bar. 

indicates you pressed Tab. 

indicates you inserted a page break. 

¶

Page Break

            The daily use of technology has

among adolescents. There is an increas

today, beyond just television watching

This can be helpful when you have a format-
ting error in your essay. For example, here 
it shows that the space bar was pressed to 
indent this paragraph instead of using the Tab 
key, which can result in uneven spacing. 

Undo

The Undo button is located in the 
Quick Access Toolbar and allows you to 
cancel your last command(s). 

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20to%20Find%20and%20Use%20the%20Ruler%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20to%20Use%20Show%20Hide%20-%20Storyline%20output/story.html
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Initial Setup of APA Papers

Set up APA format before you begin typing. You can set formatting for one paper, or you can 
change the default so that the formatting stays set for all future papers (you can always 
change this at any time), which is what the directions below will explain how to do. 

Font: We recommend using Times New Roman 12-point font in all of your papers except for 
in tables and figures, where you should use another font style. Your font should always be 
black. 

12

In the Font section of the Home tab, click on the 
arrow in the bottom, right-hand corner. 

In the Font menu, choose:
	 Font: Times New Roman
	 Font style: Regular
	 Size: 12

To save these settings for this paper only, click on OK.  

To save these settings for all future 
papers, click on Set As Default. 
Select “All documents based on the 
Normal template” and then click OK.

1

2

4 3

1

2

3

5

4

5

11
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Margins: Your margins should be set to 1 inch throughout your essay. 

To save these settings for all future papers, click on Set 
As Default.
Then click Yes.

4 3

Under the Margins tab of the Page Setup 
menu, make sure all four margins are set at 
1 inch. 

2

To save these settings for this paper only, 
click on OK.  3

5

4

2 1

In the Page Setup section of the Layout tab, click on the 
arrow in the bottom, right-hand corner. 1

5

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Format%20Margins%20-%20Storyline%20output/story.html
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Line Spacing, Indents, Text Alignment: You should change these settings  
before you start typing. Your writing should be aligned left (except for centered  
headings and titles) and your entire document should be double-spaced. 

Set Alignment to Left. 

Set Indentation to 0” 
both left and right. 

Set Line Spacing to 
double. Set Before to 0 
and After to 0. 

2

4

3

2

3

To save these  
settings for this paper 
only, click OK. 

5

4

5

To save these settings for future                         
papers, click on Set As Default, choose 
the appropriate option, and click Yes.

6

6

In the Paragraph section of the Layout 
tab, click on the arrow in the bottom, 
right-hand corner. 

1

1

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Set%20Line%20Spacing%20-%20Storyline%20output/story.html
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Page Numbers and Page Headers: While a running head (shortened  
version of your title) is no longer required for student papers, the instructions  
here include how to insert the running head with the page number if it is  
required by your instructor or assignment.

1
From the Insert tab, click on the arrow 
next to Page Number in the Header & 
Footer section. 

1

Click on Top of Page and then Plain 
Number 3. This will insert the page 
number on all pages within your  
document.  

2

2

If you need a running head, within your header (you can always double click to access it), 
put your cursor in front of the page number, type a shortened version of your title in all caps, 
and press TAB twice. Select all elements within the header and change the font (if needed) to 
the same font at the body of your paper. Then double-click below the dotted line to exit your 
header.

3

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Insert%20Page%20Numbers%20-%20Storyline%20output/story.html
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Page Breaks: You will need to manually insert page breaks at certain points in your essay—
after your title page and before your Reference list, for example. You shouldn’t press Enter 
multiple times to do this because you will create formatting issues. Instead, follow the steps 
here. 

Further research should be done to understand any socioeconomic and/or sociocultural 

reasons for the increased STBs in adolescents. 

References

Bucksch, J., Sigmundova, D., Hamrik, Z., Troped, P. J., Melkevik, O., Ahluwalia, N., 	

	 & ... Inchley, J. (2016). International trends in adolescent screen-time behaviors 	

	 from 2002 to 2010. Journal of Adolescent Health, 58(4), 417-425. 

From the Insert tab, click on Page Break. You 
can also press CTRL+Enter when typing. 

Place the cursor at the start of the paragraph 
you would like to be on a new page. Here, the 
cursor is right before “References.”

Essentially, if you cite correctly and often enough 
(see pp. 19-26 and other resources at www.write.
smumn.edu), then you should be able to avoid  
unintentional plagiarism. However, here are some 
tips to help you avoid some common challenges: 

1.	 Give yourself enough time. It’s easier to make careless errors if 
you’re rushed. 

2.	 Read the material carefully. Students sometimes plagiarize  
because they don’t fully understand the texts.

3.	 Take notes. If you are paraphrasing from your own notes, then 
you are relying on your own interpretation (include correct  
citations though). 

4.	 Visit the Writing Center. We can help you note issues with  
citations before you submit your paper. 

How do I avoid 

plagiarism?
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Table of Contents: Dot Leaders: There aren’t any APA guidelines for  
a Table of Contents; however, the instructions below will help you create  
one if your instructor requires it. You must set up dot leaders for your tab  
stops. Do not press the period key (.) repeatedly to do this as your numbers  
won’t line up correctly. 

Click OK.

Click Set. 

6

In the Tabs menu, click on Clear All.4

5
Type “6.5” into the Tab 
stop position. 5

 Select Alignment Right. 6

 Select Leader 2.7

8

9

7

8 4

9

2

Type the title “Table of Contents” (no 
quotation marks, centered) at the top of 
your page. 
On the Home tab, click on the arrow in 
the Paragraph section
Then click on Tabs... at the bottom of the 
Paragraph menu.

1

2

3

1

3

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Format%20Table%20of%20Contents%20-%20Storyline%20output/story.html
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Table of Contents: Dot Leaders, continued

Table of Contents

Background

Literature Review

Statement of the Problem 

1

3

6

..........................................................................................................

................................................................................................

....................................................................................

Type your first label for your Table of Contents. Press Tab once. A row of dots will appear, and then you can enter 
the page number. 

Table of Contents: Subheadings: You cannot indent subheadings within your Table of 
Contents using Tab. Instead, you should use the Increase Indent icon on the Home tab.

Literature Review ................................................................................................

Screen Time and Adolescents

Screen Time and Mental Health

...................................................................

................................................................

1

6

6

8

Type your subheading and then put your cursor in front of it. 1

Then press the Increase Indent button once. 2

2

We don’t recommended using any of the automatic 
functions in Word, including the Table of Contents 
and References tools. These tools don’t adhere 
to APA Style formatting and can also make other 
tools like Comments not work as well. Instead, 
use the instructions here to format these elements 
manually. 

Can I use the 

Table of Contents 

function in Word?
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Formatting Within the Paper

This section will help you format various parts of your essay, including block/indented  
quotations and headings. 

Block/Indented Quotations: While you should use exact quotations  
sparingly, if you use a quotation of 40 words or more, you will need to  
format it as a block or indented quotation as shown below. 

Paterson and Chicola (2017) described their informal mentorship as follows: 

We co-negotiated difficult solutions to problems with our pesky “human” resources; we explored structural and gover-

nance strategies; and we diffused the challenges in our personal lives by talking with an empathetic female ally who was 

at the same time a professional colleague and friend. (p. 36)

Highlight the quotation. 2

3

To format a block quotation, first type the quotation. It should be double-spaced like the rest of your paper. 1

Paterson and Chicola (2017) described their informal mentorship as follows: 

          We co-negotiated difficult solutions to problems with our pesky “human” resources; we explored structural and    

           governance strategies; and we diffused the challenges in our personal lives by talking with an empathetic female  

           ally who was at the same time a professional colleague and friend. (p. 36)

 Click on the Increase Indent icon in the Paragraph section of the Home tab. 3

Google Docs is a great tool for collaborative  
writing. For example, if you’re writing a paper with 
some classmates or if your instructor wants to 
comment on your paper during the drafting stage. 
However, a Google Docs document does not format 
in the same way as a Microsoft Word document, so 
it is best to transfer your text to a Microsoft Word 
document for formatting purposes. 

Can I use 
Google 
Docs?

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Format%20Block%20Quotes%20-%20Storyline%20output/story.html
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Word Count: You can always see your word count at the bottom, left-hand corner of your 
screen. 

You can also see your word count and 
additional information if you click on 
Word Count in the Proofing section of 
the Review tab. 

You can see the total number of words in your document at the bottom of the 
screen. To see the number of words in a section, highlight the text. You’ll then 
see a ratio of highlighted words to total words. 

Sometimes you’ll need to use a symbol either  
within your own text or within Reference list  
entries, like the section symbol (§), 
which is used when citing statutes. 
To find symbols, click on the Insert
tab in Word and then click on the 
little arrow next to Symbol within 
the Symbols section. 

How do I  
type §  
and other 
symbols? 

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Insert%20Symbols%20-%20Storyline%20output/story.html
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Word Help
Check out these videos for additional help

How to: Alphabetize
How to: Create a Hanging Indent
How to: Format Block Quotes
How to: Format Margins
How to: Set Line Spacing
How to: Paste
How to: Set Paragraph Alignment
How to: Format Table of Contents
How to: Insert Page Numbers

Bulleted or Numbered Lists

Click on the Increase Indent icon to indent the list 0.5 inches.Type the list and then highlight it.

There are a variety of health concerns related to both STBs and the resulting sedentary 

behaviors of teens: 

•	 Higher STBs predicted obesity in teens, especially for teens who have a TV 

in their bedrooms (Wethington et al., 2013). 

•	 Cholesterol levels and high blood pressure were more likely in teens who had 

excessive STBs (Tremblay et al., 2011). 

•	 Lower self-worth and self-esteem levels were found in teens with higher 

levels of STBS (Tremblay et al., 2011).

Click on the Bullet icon                  or the Number icon                 in the Paragraph section of the Home tab.  

3

2 3

1

Use numbers when the  
order of the items is  
important, for example, 
when you are listing the 
steps in a process. 

Use bullets when the order 
isn’t important. 

1

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20to%20Alphabetize%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Create%20a%20Hanging%20Indent%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Format%20Block%20Quotes%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Format%20Margins%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Set%20Line%20Spacing%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20to%20Paste%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20to%20Set%20Paragraph%20Alignment%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Format%20Table%20of%20Contents%20-%20Storyline%20output/story.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Insert%20Page%20Numbers%20-%20Storyline%20output/story.html
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Orphan Headings: Use the instructions below to ensure your headings  
are not orphaned at the bottom of the page.

 

2

1

Click OK.5

Put your cursor in front of the first letter of the heading.

On the Home tab, click the arrow in the bottom, right-hand               
corner of the Paragraph section. 

1

2

3

4

In the Paragraph menu, click on the Line 
and Page Breaks tab. 

Select “Keep with next.” 

3

4

5

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20to%20Fix%20Orphan%20Headings%20-%20Storyline%20output/story.html
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Irregular Line Spacing: If you cut and paste text from various documents, you may  
end up with irregular line spacing. For example, you might have a triple space between 
paragraphs rather than a double space. 

4

3

In the Paragraph menu, set the Spacing to 0 pt for both 
Before and After. 3

Click OK.4

1
2

Highlight the text with the issue OR click on the arrow next 
to Select to Select All if you have multiple areas with this 
issue. 

On the Home tab, click the arrow in the bottom, right-hand 
corner of the Paragraph section. 

1

2
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Reference List
This section will address the formatting of your Reference list, including hanging indents and 
alphabetizing. 

Hanging Indent: Do not create hanging indents manually—doing so will  
cause formatting issues if you revise anything on this page.
 

Bucksch, J., Sigmundova, D., Hamrik, Z., Troped, P. J., Melkevik, O., Ahluwalia, 

	 in adolescent screen-time behaviors from 2002 to 2010. Journal of Ado	

org/10.1016/j.jadohealth.2015.11.014

In a hanging indent, the first line of each citation is aligned left, and all 
subsequent lines are indented.

1
Click on the arrow in the 
bottom, right-hand corner of 
the Paragraph Section of the 
Home tab. 

1

2

3

In the Paragraph 
menu, under Special, 
select Hanging, and 
change the spacing to 
0.5 inches.

2

Click OK.3

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20To%20Create%20a%20Hanging%20Indent%20-%20Storyline%20output/story.html
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Copy & Paste APA References: You can copy and paste Reference list  
entries from a database to save time; however, you need to do it correctly  
to avoid any formatting errors. You should do this process after you have  
formatted your Reference list hanging indents, margins, font, etc. 

1

From the 
Detailed Record 
page in  
SuperSearch, 
click on Cite.             

1

This will pull up a list 
of entries in various 
styles. Scroll down to 
find APA.

Highlight this entry, 
right-click and select 
Copy.      

2

3

In Word, right-click and then select the Merge Formatting                          
option under Paste Options. This will paste the entry into your 
Reference list. (You might also use the Keep Text Only option 
here, depending on how you’ve formatted the rest of your 
page.)
You should review the entry for correctness, especially in 
terms of capitalization.5

4

4

2 3

http://
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Alphabetize Your Reference List Entries: Once your Reference  
list is complete, you can alphabetize your Reference list entries easily,  
using the Sort icon.

References

Bucksch, J., Sigmundova, D., Hamrik, Z., Troped, P. J., Melkevik, O., Ahluwalia, N., & ... Inchley, J. 2016). International trends 

in adolescent screen-time behaviors from 2002 to 2010. Journal of Adolescent Health, 58(4), 417-425. https://doi.

org/10.1016/j.jadohealth.2015.11.014

Craig, S., McInroy, L., McCready, L., Cesare, D., & Pettaway, L. (2015). Connecting without fear: Clinical implications of the 

consumption of information and communication technologies by sexual minority youth and young. Clinical Social Work 

Journal, 43(2), 159-168. https://doi.org/10.1007/s10615-014-0505-2

Highlight your entries (be 
sure to exclude the title of 
References).

1

2

4

3

Click on the Sort icon in the Paragraph 
section of the Home tab.

Under Sort by, be sure that Paragraphs 
and Ascending are selected. 

Click OK. 

2

3

4

http://www2.smumn.edu/deptpages/tcwritingcenter/Word%20Videos/How%20to%20Alphabetize%20-%20Storyline%20output/story.html
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Matching Reference Entries to In-text Citations: You can use the Find tool in Word 
to check for consistency between your in-text citations and Reference list entries. 

This will bring up the Navigation 
pane, which allows you to see 
each time this name is used in 
your paper. 

3

References

Bucksch, J., Sigmundova, D., Hamrik, Z., Troped, P. J., Melkevik, O., Ahluwalia, 		

	 N., & ... Inchley, J. (2016). International trends in adolescent screen-time behaviors from 		

	 2002 to 2010. Journal of Adolescent Health, 58(4), 417-425. doi:10.1016/j.j

2

4

Highlight the first last name in an 
entry on your Reference list. Be sure 
to highlight the name only. 

Click on the Find icon within the 
Editing section of the Home tab.

1

2

You can click on each item or use the arrows 
to scroll through each instance and check for 
correctness. 

4

Bucksch et al. (2016) added  that these “screen-time behaviors” 

have become normalized due to “the availability of screens, ready 

access to the Internet, and the increasing importance of social 

media in young people’s lives” (p. 422).)  Screen time is increas-

ing because technologies pervade the everyday life experiences of 

teenagers: using Ipads at school, listening to music on cell phones, 

and checking in with parents on Facebook. Bucksch et al. (2016) s
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� 13
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Index
Reference list, 10-18

alphabetize references quickly, 43
author & publisher are the same, 13
author element, 10
author, missing, 12
authors, multiple (using et al.), 22
book, chapter, 13
book, print, 13
copy APA database reference, 42
course materials, 16
date element, 11
DOI numbers, 15
ERIC database, 15
four elements of an APA entry, 10-11 
journal article, library database, 15
journal article, print, 13
legal documents, 17-18
motion picture, 16
newspaper article, 13
online video (YouTube), 16
primary & secondary sources, 9
publication date, missing, 12
publisher element, 12
title element, 11
title, missing, 12
titles, how to format, 5
website document, 14

Ruler bar, 28
Secondary sources, 9
Spacing

Line spacing, 3, 31
Symbols, 37
Table of contents, 34-35

indent subheadings, 35
Tables & figures, 6-7

citing, 6
format, 6
samples, 7

Title element, 11
Title page, 4
Titles, 5

capitalization/case, 5
in your paper, 5
on the References list, 5

Word count, 37

Lists
bulleted, 5
how to format in Word, 38
lettered, 5
numbered, 5

Margins, 3, 30
Missing elements, 12
Motion picture, reference, 16
MS Word for APA, 27-44

alignment, 31
alphabetize, 43
center, 31
font, 29
headings, prevent orphans, 39
indents, 31

block quotes, 36
hanging indents, 41

line spacing, 31
correct irregular, 40

lists, 38
margins, 30
page breaks, 33
page headers, 32
page numbers, 32
ruler bar, 28
show & hide, 28
table of contents, 34-35
undo, 28
word count, 37

Numbered lists, 5
formatting, 38

Orphan headings, 3, 39
Page breaks, 33
Page numbers & headers, 3, 32
Paraphrases, 25-26
Periodicals, 13

journal article, print, 13
journal, database, 15
newspaper article, 13

Personal communication, 11
Plagiarism, 33
Primary & secondary sources, 9
Publisher element, 12
Quotations, 23 

blocked, 23, 36
integrating, 24

Alignment, 1, 31
Alphabetize references, 43
Appendices, 8
Author element, 10

author missing, 12
authors, multiple (using et al.), 22

Block quotes, 3, 23, 36
Books, 13

chapter in edited, 13
multiple authors, 22

Bulleted lists, 5, 38
Citing sources in your paper, 19-22

personal communication, 11
relationship to Reference list, 20
running text vs. parenthetical, 20-21

Common knowledge, 19
Copy APA database reference, 42
Date element, 11
DOI Numbers, 15
Dot leaders, 34-35
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